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CZYM SĄ ESCAPE ROOMY?

KORZYŚCI DYDAKTYCZNE I WYCHOWAWCZE ZE STOSOWANIA ESCAPE ROOMÓW

Escape room to rodzaj tematycznej zabawy w grupie. Zespół uczestników musi rozwiązać szereg zadań i zagadek, aby 
osiągnąć cel przedstawiony na początku gry. Najczęściej jest nim opuszczenie zamkniętego pokoju lub otwarcie skrzyni, 
w której znajduje się przedmiot potrzebny do ukończenia zabawy. Pierwsze tego typu atrakcje pojawiły się w Azji. 
Wraz z popularnością zaczęły zdobywać także pozostałe kontynenty. 

Kompetencje społeczne. Escape roomy są zaprojektowane do pracy w grupie. 
Uczestnicy muszą działać jako zespół, komunikować się ze sobą, 
a także wymieniać się spostrzeżeniami oraz pomysłami.

Myślenie lateralne. By rozwiązać łamigłówki, trzeba kompleksowo spojrzeć 
na problem, połączyć kolejne elementy zadań oraz myśleć 
w sposób nieschematyczny.

Zarządzanie czasem i planowanie. 
Działanie w grupie pod presją czasu wymaga 
dokładnego planowania oraz przewidywania.

Rozwiązywanie problemów. 
Pokoje zagadek prezentują różnorodne typy łamigłówek 
(np. szyfry, kody, puzzle, zagadki). 
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WIRTUALNE ESCAPE ROOMY - SCHEMATY GRY

Otwarty 
Uczestnicy rozwiązują łamigłówki 
w dowolnej kolejności. Dopiero 
gdy to uczynią, łączą rozwiązania 
w całość, aby osiągnąć cel gry.

Wieloliniowy 
Ten schemat składa się 
z kilku ścieżek liniowych. 
Po przejściu każdej z nich 
uczestnicy otrzymują wskazówki, 
które należy połączyć, aby 
osiągnąć cel gry.

Liniowy 
W tym przypadku istotna jest 
kolejność rozwikłania zagadek. 
Każde kolejne rozwiązanie 
daje wskazówkę niezbędną do 
wykonania następnego polecenia.

Piramidowy 
To najtrudniejszy 
i najbardziej 
rozbudowany schemat. 
Świetnie się sprawdza 
w pracy w grupach.

Rodzaje schematów escape roomów
Źródło: oprac. Ksenia Erdman
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TWORZENIE POKOJÓW ZAGADEK

Historia przewodnia i cel
Tworzenie pokoju zagadek rozpoczyna się od zaplanowania głównego celu zabawy. Na tym etapie 
należy zdecydować, czy escape room będzie mieć za zadanie przekazanie wiedzy, nauczenie uczestników 
pewnych umiejętności czy też zintegrowanie zespołu. Następnie trzeba stworzyć historię przewodnią gry. 
Wystrój pomieszczenia oraz rodzaj zagadek i zadań będą zależeć od obranej tematyki.

Zagadki i zadania
Kolejny krok to wybór rodzajów zadań. Decydując się na konkretne typy zagadek,  
należy pamiętać o odpowiednim dobraniu stopnia ich trudności oraz różnorodności. 

Plan
Planowanie zabawy rozpoczyna się od końca, tj. od przypisania zadań, które mają zaprowadzić 
uczestników do otwarcia finałowej skrzynki lub drzwi. Następnie do każdej cyfry kodu do kłódki 
należy dobrać odpowiednie polecenia wybrane w poprzednim punkcie. Kolejne dyspozycje dopisuje się 
w zależności od wybranego typu escape roomu (otwarty, liniowy, wieloliniowy lub piramidowy).

Przygotowanie grafiki nawiązującej do klimatu gry
Tło i obrazki na slajdach uatrakcyjnią grę. Należy pamiętać o prawach autorskich i pobierać grafikę 
z legalnych źródeł. Strony, gdzie znajdują się pliki na wolnej licencji, to m.in. pixabay.com, 
freepik.com, flickr.com.

Sprawdzenie poprawności 
Nawet najmniejszy błąd może spowodować, że zabawa się nie uda. Pomyłka w cyfrze czy słowie potrafi 
uniemożliwić otwarcie kłódki, co przekreśli szansę uczestników na ukończenie gry. Do sprawdzenia,  
czy wszystko się zgadza, warto zaangażować kogoś, kto nie brał udziału w tworzeniu escape roomu. 
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NARZĘDZIA DO TWORZENIA WIRTUALNYCH ESCAPE ROOMÓW

Szkielet escape roomu online najczęściej tworzy się w aplikacji Genially  
lub w formularzach Google.  
Poszczególne zadania można budować w oparciu o: 

Festisite
	 	 	 festisite.com
Dzięki tej stronie internetowej można w łatwy sposób wygenerować 
m.in. labirynty bądź rebusy.

Jigsawplanet
	 	 	 Jigsawplanet.com
Na tej witrynie można uzyskać puzzle z przygotowanego wcześniej obrazka i osadzić 
link do gry w Genially. Istnieje również możliwość umieszczenia na obrazku treści 
zadania, która będzie czytelna dopiero po ułożeniu puzzli.

Prescriptionmaker i tickets
	 	 	 prescriptionmaker.com	oraz
Za pomocą strony w łatwy sposób można stworzyć grafikę, która będzie przedstawiać 
odpowiednio receptę lub bilet lotniczy. Tak przygotowane grafiki mogą być świetnym 
sposobem ukrycia istotnych informacji potrzebnych do rozwiązania zadania.

News
	 	 	 classtools.net
Witryna z grafiką w formie telewizyjnych wiadomości.

Wanted
	 	 	 mobilefish.com/services/wanted_poster/wanted_poster.php 
Ten portal daje możliwość stworzenia plakatu jak z westernu.

Odwrócony tekst
	 	 	 flipyourtext.com
Strona pozwalająca na wygenerowanie tekstu w odbiciu lustrzanym.

Fejkowy SMS 
	 	 	 ifaketextmessage.com		|			iphonefaketext.com
Witryna, dzięki której można przedstawić rozmowę w formie wiadomości SMS.

Fejkowe konto na instagramie
	 	 	 zeoob.com/generate-instagram-post
Strona umożliwiająca stworzenie grafiki wyglądającej jak post na Instagramie.

Secret Message
	 	 	 worksheetworks.com/math/geometry/graphing/secret-line-message
Generator wiadomości zakodowanej w układzie współrzędnych.

Link, do którego przejdzie się po podaniu hasła
	 	 	 thinfi.com
Witryna, dzięki której można wygenerować link do innej strony internetowej po podaniu 
odpowiedniego hasła.

Gazeta
	 	 	 www.fodey.com/generators/newspaper/snippet.asp	
Generator grafiki w formie nagłówka gazety.
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ESCAPE ROOM W GENIALLY- PIERWSZE KROKI

Na platformie zakładamy darmowe konto. 

W tym celu wchodzimy na stronę www.genial.ly
i klikamy sign	up w prawym górnym rogu. 
 
Po stworzeniu konta logujemy się 
i możemy przystąpić do tworzenia 
pierwszego projektu.

Na początek należy założyć konto na 
platformie genially. Konto może być 
bezpłatne albo w wersji rozszerzonej. 
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TWORZENIE NOWEJ PREZENTACJI I OBSZAR ROBOCZY

Kliknięcie niebieskiego plusika z napisem Create genially 
umożliwi wybór rodzaju tworzonej prezentacji. 
Program oferuje wiele gotowych wzorów oraz szablonów, 
można też skorzystać z czystej prezentacji.

Po wybraniu Blank creation 
(ostatnia pozycja na liście) 
należy przejść do Presentation

Następnie należy kliknąć przycisk 
 Use this template

Spośród zaproponowanych slajdów 
trzeba wybrać White → Add. 

1 2 3

4567
Przestrzeń do pracy
jest gotowa!
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NAJWAŻNIEJSZE ELEMENTY PRZESTRZENI ROBOCZEJ 

8

NAJWAŻNIEJSZE ELEMENTY PRZESTRZENI ROBOCZEJ

Dodawanie pola tekstowego, 
punktorów, numeracji

Wstawianie pliku graficznego 
(z komputera bądź wbudowanej bazy)

Wstawianie przycisków i interaktywnego pola

Wstawianie audio, video oraz linków

Wstawianie ikon, kształtów, wykresów, strzałek

Wstawianie tabel, diagramów, wykresów, kolaży

Wybór tła

Podgląd stron projektu

cofanie i przywracanie 
wykonanej czynności

nazwa projektu

dodawanie 
nowej strony usuwanie

strony
wybór
strony

zmiana wymiarów
strony

zmiana przejścia
między slajdami

podgląd projektu
publikowanie projektu
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Po kliknięciu elementów takich jak przyciski, 
obrazy i inne możemy nadać im interaktywność 
poprzez przypisanie im funkcji.

Kliknięcie ikony z palcem wskazującym rozwinie 
dodatkowe menu z najważniejszymi funkcjami, 
które można przypisać wybranemu elementowi 
(w tym przypadku strzałce). Należy wybrać Go to page 
i zaznaczyć slajd, do którego ma przenieść strzałka. 
Ten proces trzeba powtórzyć dla wszystkich strzałek.

9

Rączka sprawia, że 
element będzie ruchomy.

Palec wskazujący 
nadaje elementowi 
interaktywność.

Ostatni przycisk nadaje 
ikonie animacji funkcję 
wejścia lub wyjścia.

Kłódka blokuje element 
przed przypadkowym 
przemieszczeniem.

Po kliknięciu na element 
pojawi się małe okienko 
z wpisanym tekstem. Po kliknięciu na element 

pojawi się okno zawierające 
tekst lub obraz

Kliknięcie na element 
spowoduje przeniesienie 
do wybranej strony.

NAJWAŻNIEJSZE ELEMENTY PRZESTRZENI ROBOCZEJ
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Tworzenie escape roomu rozpoczyna się od przygotowania scen/pomieszczeń, 
w których będzie się toczyła gra. Należy dodać kilka stron do prezentacji i uzupełnić 
je grafikami. Te warto przygotować wcześniej, pamiętając o poszanowaniu praw 
autorskich. Aby dodać nową stronę, trzeba kliknąć Add page u dołu ekranu. 
Wszystkie stworzone wcześniej slajdy można przeglądać w zakładce Pages, 
która znajduje się z lewej strony. 

Podstawą udanego escape roomu są grafiki. Stanowią one bazę oraz tło gry, a także 
wpływają na zaangażowanie uczestników zabawy. Aby dodać tło, należy kliknąć przycisk 
Background z bocznego paska i wybrać jedną z zaproponowanych opcji. Można wgrać 
przygotowane wcześniej zdjęcia z komputera lub wyszukać je w legalnych źródłach.

10

DODAWANIE NOWYCH STRON I TŁA



es
ca

pe
 ro

om
 o

nl
in

e 
- g

en
ia

lly
WSTAWIANIE GRAFIKI I POLA TEKSTOWEGO

https://view.genial.ly/6182f1939210230da006c3bd/interactive-content- untitled-genially
11

Z panelu bocznego należy wybrać opcję Image. Pojawią się wówczas następujące 
możliwości: dodanie pliku z komputera, dysku wirtualnego, z sieci (poprzez podanie linku). 

Aby wstawić pole tekstowe, trzeba kliknąć ikonę Text z menu po lewej stronie i wybrać 
odpowiednią wielkość czcionki. Dane pole tekstowe można edytować, zmieniając rodzaj, 
kolor czy wielkość czcionki. 

Poniżej są przedstawione najważniejsze opcje edytowania tekstu:

Stwórz swój pierwszy escape room krok po kroku

Poszczególne slajdy z prezentacji przygotowanej na potrzeby niniejszej publikacji są dostępne w internecie: 

Kopiowanie, 
powielanie, usuwanie 
i blokowanie tekstu

Przezroczystość, kolor, rodzaj  
i wielkość czcionki.

Pogrubienie, kursywa, 
podkreślenie tekstu

Warstwy oraz pozycja tekstu
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Na początek należy dodać kilka 
pustych slajdów. Po kliknięciu 
przycisków Add page → Blank 
pojawi się nowa strona. 
Teraz wystarczy ją skopiować kilka 
razy. Po najechaniu myszką na pusty 
slajd pojawi się ikona z dwiema 
kartkami. Trzeba na nią kliknąć 
i następnie dodać kolejne puste 
strony projektu.

Jako tło (przycisk Background) 
pierwszego slajdu należy wybrać grafikę 
z zasobów pixabay. Następnie trzeba 
dodać przycisk wprowadzający do gry, 
wybierając kolejno: 
Interactive elements → Button with tekst 
→ Start 

Po kliknięciu wyrazu Start przycisk ten 
staje się interaktywny.
Po tym należy wybrać opcję 
przekierowania do kolejnej strony, 
czyli kolejno: 
Go to page → Next page → Save 

Następnie trzeba kliknąć ikonę kłódki, 
aby gracz nie mógł przesuwać przycisku.

Pierwszy slajd jest już prawie gotowy. 
Należy dodać jeszcze tytuł gry poprzez kliknięcie opcji: 
Text → Title 2 (w tym przypadku: Escape Room). 

Trzeba kliknąć na treść, zablokować ją za pomocą kłódki 
i dodać animację (ikonka przedstawiająca kometę). 

Po tym należy wybrać rodzaj oraz długość animacji. 
W tym przypadku będą to następujące ruchy: 
Animation → Entrance; 
Direction → Freeze; Effect → Turn on; Start → 0 
(tekst pojawi się tuż po otwarciu prezentacji); 

Speed → 3 sec 
(element będzie ruchomy przez trzy sekundy, 
po tym czasie zatrzyma się w wyznaczonym miejscu).

TWORZENIE ESCAPE ROOMU – KROK PO KROKU

12
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Slajd 1

Slajd 2

Slajd 3

Na drugim slajdzie trzeba umieścić historię wprowadzającą do gry poprzez naciśnięcie 
przycisków Text → Subtitle. Warto zadbać o to, aby była ona ciekawa 
i interesująca dla odbiorców. Kolor czcionki należy wybrać taki, by tekst był widoczny, 
zaś tło powinno być spójne z fabułą. 
Na koniec dodaje się przycisk w postaci strzałki, odpowiednio klikając 
Interactive elements → Buttons – odtąd będzie on przekierowywał uczestników 
gry do kolejnej strony, podobnie jak w przypadku przycisku Start. 
Aby dodać animację, należy kliknąć ikonę komety. Ponieważ zależy nam na tym, 
aby gracze dokładnie przeczytali list wprowadzający, wobec tego trzeba opóźnić 
pojawienie się przycisku poprzez wybranie: Start → 10 sec. Należy pamiętać także 
o zablokowaniu elementu za pomocą kłódki (przy dalszym tworzeniu escape roomu 
również trzeba to robić, ale w poniższym tekście nie będzie już to wspominane).

Trzeci slajd to rozpoczęcie zabawy. 
Po dodaniu tekstu (instrukcji) należy wstawić „niewidoczne przyciski” 
na drzwiach poprzez Interactive elements → Invisible area. 
Następnie trzeba kliknąć Drag this area...
Na slajdzie pojawi się błękitny prostokąt, który będzie widoczny 
tylko podczas edycji. Należy dopasować wielkość tego prostokąta 
i nałożyć go na pierwszą parę drzwi. Czynność tę trzeba powtórzyć 
dla wszystkich drzwi. 

Następnie każdemu z siedmiu elementów przypisuje się przekierowania. 
Zadania trzeba ukryć tylko za czworgiem drzwi (o numerach: jeden, 
trzy, pięć i sześć). Kliknięcie w drzwi przeniesie uczestników do slajdu 
czwartego, trzy do slajdu piątego, pięć do slajdu szóstego, zaś sześć 
do slajdu siódmego. Drzwi numer dwa, cztery i siedem też będą miały 
dodaną funkcję. Po ich kliknięciu pojawi się komunikat: „Nic tu nie ma”. 

By stworzyć ten tekst, należy kliknąć na pole na drzwiach → ikona 
z palcem wskazującym → przycisk Window (tu trzeba wpisać tekst) 
→ Save.

13
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UKRYWANIE ZAGADEK I ZADAŃ
Zagadki zostaną umieszczone na slajdach od czwartego do siódmego. 
Podobnie jak przy slajdzie z drzwiami, głównym narzędziem, które posłuży do ukrycia 
zadań, będą „niewidoczne przyciski”: 
Interactive elements → Invisible area. 

Na slajdach prezentujących pomieszczenia, które znajdują się za drzwiami, należy 
wstawić tło oddające charakter historii oraz gry. Następnie trzeba wybrać na slajdzie 
ciekawe miejsce (w tym przypadku kartka) i wstawić Invisible area. 

Należy dostosować rozmiar tego obszaru tak, aby pokrył powierzchnię kartki z ilustracji, 
a następnie trzeba dodać interaktywność przenoszącą do kolejnego slajdu 
(slajd numer osiem).

Na następnym slajdzie należy wstawić zagadkę (np. w postaci tekstu, zdjęcia lub aplikacji 
zewnętrznej za pomocą funkcji Insert → Others). Tutaj zadanie będzie miało formę 
grafiki. Aby wstawić zdjęcie, należy kliknąć przyciski Image → Your computer 
i wybrać z dysku przygotowaną wcześniej zagadkę. 

Na tym samym slajdzie nie może zabraknąć przycisku powrotu do poprzedniego slajdu. 
Aby to zrobić, trzeba kliknąć Interactive elements i wybrać przycisk strzałki. Następnie 
trzeba nadać jej interaktywność poprzez funkcję Go to page i wybrać slajd numer cztery. 
Należy pamiętać o dodawaniu możliwości powrotu do poprzedniego slajdu, ponieważ 
brak tej opcji uniemożliwi graczowi kontynuację gry (w dalszej części instrukcji nie będzie 
już to wspominane). 

Slajd 414

Pierwsza zagadka jest gotowa.1
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UKRYWANIE ZAGADEK I ZADAŃ

Na slajdzie numer pięć znajduje się pomieszczenie z telewizorem, 
na którym należy umieścić Invisible	area. 
Aby osadzić w nim film z YouTube, trzeba kliknąć Insert	→	Others i w górnym 
polu wkleić link do osadzania (Embed	code). Taki link uzyska się poprzez 
wybranie danego filmu z YouTube, a następnie kliknięcie kolejno: Udostępnij 
→ Umieść. W podobny sposób można zamieścić wszystkie elementy, które 
posiadają link do osadzania oznaczony symbolem </>. 

W tym samym pomieszczeniu trzeba ukryć również zagadkę w postaci tekstu, 
która odnosi się do informacji w filmie. 

        Drugie pomieszczenie jest gotowe.

Kolejne zadanie należy ukryć w pomieszczeniu znajdującym się za drzwiami 
numer pięć. Na szóstym slajdzie zostanie umieszczone zadanie w postaci 
puzzli. Przygotowane wcześniej elementy wstawia się jako zdjęcia poprzez 
funkcje Insert	→	Your	computer. Aby elementy były ruchome podczas gry, 
należy wybrać każdy z nich i zaznaczyć opcję Drag. Wszystkie elementy, 
które wstawia się do genially, można ustawić jako ruchome, dzięki czemu 
uczestnicy zabawy będą mogli poruszać nimi po slajdach.

15
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Za drzwiami numer sześć zostanie ukryte zadanie, którego odnalezienie będzie 
wymagać użycia „latarki”. W tym celu należy przenieść się na slajd numer 7. 
Czarne tło można ustawić poprzez funkcje Background	→	Color. 
Po tym należy dodać koło, wybierając przyciski Resources	→	Shapes. 
Po wybraniu kształtu trzeba dostosować jego wielkość oraz kolor. 
To koło ma imitować światło latarki, więc idealny do tego będzie kolor żółty. 
Element ten powinien być ruchomy, dlatego należy zaznaczyć opcję Drag. 
Następnie trzeba dodać treść łamigłówki. W tym celu należy wybrać opcję Text oraz 
ustalić odpowiednią wielkość czcionki. 
Po tym pozostaje jedynie wpisać zagadkę.
 
Pole tekstowe należy umieścić w odpowiednim miejscu na slajdzie. 
Zarówno tło, jak i czcionka są czarne, więc tekst jest niewidoczny. 
Teraz należy przesunąć żółte koło na tekst, aby sprawdzić, czy jest on czytelny. 
Zadanie polega na manewrowaniu żółtym kółkiem po slajdzie i odnalezieniu 
wszystkich ukrytych wiadomości. Przy tej zagadce warto także wspomnieć 
o warstwach. Aby łamigłówka z latarką zadziałała, koło musi znaleźć się między tłem 
a tekstem. Jeżeli jest inaczej, można to zmienić, klikając ikonę warstw. 

       Trzecia zagadka skończona.

Za ostatnimi, siódmymi, drzwiami znajdzie się slajd kończący grę. Na tym o numerze 
dziewięć należy dodać tekst z zakończeniem historii oraz gratulacje. Aby zabezpieczyć 
go hasłem, trzeba wybrać opcję Pages. Po wybraniu slajdu należy kliknąć 
Options	→	Add	password	for	the	page. Po wpisaniu hasła przejście do tego slajdu 
będzie możliwe tylko po uzyskaniu poprawnych cyfr z poprzednich zagadek.
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ZAKOŃCZENIE PROJEKTU

Po skończonej pracy nad projektem escape roomu należy sprawdzić, 
czy wszystkie funkcje i elementy gry działają prawidłowo. 
W tym celu trzeba kliknąć na ikonę podglądu w prawym górnym rogu. 
W tym momencie widoczne są jeszcze strzałki umożliwiające przejścia między 
slajdami, jak w klasycznej prezentacji. Aby to zmienić, należy wybrać menu 
z prawej strony (symbol trzech kropek), a następnie Navigation	→	Microsite.
 
Po upewnieniu się, że wszystko działa tak, jak należy, można udostępnić 
projekt gry. W tym celu trzeba wybrać menu znajdujące się tuż obok ikony 
podglądu projektu.

W zakładce Display należy wyłączyć funkcję Interactive	indicator, w innym 
wypadku wszystkie elementy gry, które powinny być niewidoczne, będą 
oznaczone i widoczne. W zakładce Privacy można wybrać, czy udostępniona 
gra będzie w wersji Reusable, czyli do edycji. Można tam także nadać tytuł 
i dodać opis gry. Gdy wszystkie opcje zostaną wybrane, wystarczy kliknąć 
przycisk Share i skopiować link do udostępnienia.
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Rebusy

Kodowanie

Świetnie sprawdzą się proste rebusy, 
ponieważ łączą elementy matematyki 
z dobrą zabawą. Dobór grafik, które 
nawiązują do opowiadanej historii, 
oraz kilka prostych działań dają 
możliwość ukrycia dowolnej cyfry.

Dzięki opcji Drag oraz możliwości 
poruszania elementami po genially 
można także wykorzystać elementy 
kodowania. Zadanie polega 
na ułożeniu kwadratów na 
odpowiednich polach według 
podanych współrzędnych.
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Folia

Puzzle

Wykorzystując opcję przezroczystości, można 
stworzyć dwie łamigłówki znane ze stacjonarnych 
escape roomów. Pierwsza to tekst widoczny 
przez czerwoną folię. Informację należy ukryć pod 
czerwonymi szlaczkami, a następnie trzeba dodać 
czerwony prostokąt z ustawioną przezroczystością 
i opcją Drag. W ten sposób po nałożeniu prostokąta 
na tekst stanie się on czytelny.

Funkcja Drag doskonale się sprawdza przy 
wykorzystaniu puzzli i układanek. Tekst sekretnej 
wiadomości należy zapisać na elementach puzzli 
w taki sposób, aby stał się on czytelny dopiero 
po ich ułożeniu.

Innym pomysłem, również wykorzystującym 
funkcję przezroczystości elementów, jest ukrycie 
fragmentów tekstu na kilku różnych kartkach. Tekst 
stanie się czytelny dopiero wtedy, kiedy uczestnicy 
nałożą wszystkie kartki jedna na drugą.
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